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               0.5 

- 

This document is a guide to assist you with the functionality of AirIQ Fleet. 

AirIQ Fleet is now entirely mobile friendly, so everything you do on your computer can now be done from your 

smartphone or tablet. You can follow the steps as shown in this guide on your mobile device. 

 

 

 From Google Chrome or Mozilla Firefox, visit airiqfleet.com. 

  Also works on mobile! 

 Note: AirIQ Fleet is no longer supported by Internet Explorer or other legacy browsers. 

 

 Log in to your new account using the credentials provided to you. 

   

Upon successful login, the new AirIQ Fleet will appear with a map of North America: 

 

 

 

Quick Access Guide 

  Accessing AirIQ Fleet 

https://airiqfleet.com/
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On your first login, you’ll notice a features and tips banner – hover over it to close it. 

 

New Twitter notifications are displayed by a flashing Twitter logo in the top right corner that pulsates if there are 

new tweets available. Tweets usually include system updates and notifications regarding any changes made to 

AirIQ Fleet, such as new features or UI updates. 

 

 

 

➌ To perform a search or narrow your criteria, select “Search.” 

- 

You’ll then see a small popup box where you can search by category 

and enter any filters that correspond to the category you selected. You 

can search by VIN, Make, Model, License Plate and more. 

To remove any search criteria from your Filter(s), select the “x” next to 

the name. 

Once you select search, the assets you searched for are now visible on 

the map and your grid, with the most recently retrieved information 

shown. 

 

 

 

Various actions can be performed 

on your assets, depending on 

your company profile and user 

access rights. 

You’ll find them under the 

“Actions” dropdown menu, as 

shown here: 

 

TIP: Any time you’re using AirIQ Fleet, enter a location into 
the search box and the map will zoom to that area. 

  Performing Actions 
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 To perform an action on an asset, select the asset’s icon on the map or 
select the asset’s row in your grid, and select “Actions.” 

 To select multiple assets, use the grid’s checkboxes before selecting 

the action you wish to perform. 

After selecting an action, an action submission window will pop up with your 

asset and other options (if you picked more than one asset, you will see 

multiple under “Selected Assets”). 

After the action is submitted, a loading bar will appear. Once the device 

has completed the action you sent it, the loading bar will show “Successful” 

and the asset’s updated position and details will be displayed on the map 

and in the grid. 

 

 

 

 To view an asset’s history, select the History Query icon  
in the asset’s Actions column. 

 This is found on the leftmost side of your details grid. 

 

 In the window that pops up, input your desired timeline to retrieve history 
data for, and select “Submit.” 

 

You can use the calendar icon (  ) to specify a month, day and year. 

 

You can use the clock icon to (  ) specify a time in 15 minute intervals.  

 

Note that the end date must be later than the start date or you will be unable 

to perform the history query. 

 

 

  Accessing Historical Data 
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If the selected criteria returns a substantial number of plots the details box will filter out tracking events, 

however ALL plots will be displayed on the map. If you have a substantial number of plots for the 

timeframe you selected, we recommend that you either select a smaller time frame or run your data via 

a History Report. 

 

 

Upon a successful query, you will see travel lines and pinpoints on the map indicating where the 

asset has travelled in the timeframe you defined in step 2. 

 

 

 

 

 

TIP: You can zoom in and out of the map by scrolling up or down, or selecting the + / - 
buttons on the bottom right. You can also use the drag zoom icon in the top left of the map. 
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The Radius Search tool allows users to search historical data within a pre-selected radius anywhere 

on the map. 

 

 Select “Search” from the menu bar and search/select the assets                              
of your choice 

 You can also select “Get All” to select all of your available assets. 

 

 In the top left of the map on AirIQ Fleet, select the small grey circle icon 
and draw a circle. 

 

Your cursor will turn into a + and you’ll be able to draw a circle on 

the map by clicking anywhere, holding and dragging. 

 

 

To resize the radius you’ve drawn, click it once and you’ll see 4 smaller circles show up around the edge – you 

can use those to drag and resize the circle. To delete the radius so you can draw another, double click on it. 

 

 

  

 Using the Radius Search tool 

Note: This search method will only search your preselected assets. 
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➌ Proceed as you would with searching historical data, ensuring you click 

the “Search within drawn circle” box noted below, then select “Submit.” 

 (Refer to the “Accessing Historical Data” section for more information regarding performing a 

history query.) 
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 Search and select the asset you wish to work with. 

 Use the same steps as outlined under “Accessing AirIQ Fleet” (step 3) 

 

 Select the “edit” button      in the data grid.  

 

The “Edit Asset” window will pop up allowing you to edit 

any information regarding this asset you wish. 

You can now change the desired fleet the asset is in 

directly in the Asset editor. 

The “Asset Type” you select (the first dropdown), for 

example a car or truck, will reflect the icon that is 

displayed on the map. 

Once you are finished modifying your asset details, click 

the             button to confirm and save your changes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Editing asset details 
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Note: We recommend you calibrate your odometer or engine hours with the correct value of the asset 
upon installation to obtain the most benefit from the AirIQ solution. This is not required if the asset has an ECM 
connected device, as the odometer details will automatically be captured as long as the asset make and model 
support this feature. 

 

 Search and select the asset you wish to work with. 

 Use the same steps as outlined under “Accessing AirIQ Fleet” (step 3) 

 

 In the data grid, select the icon for the action you wish to perform: 

  Calibrate odometer 

  Calibrate engine hours 

 

Calibrating your odometer:      Calibrating your engine hours: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Calibrate odometer and/or engine hours 
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Regardless of which you choose, both windows will look very similar. You will see the name of your 

asset code that you’re currently calibrating, the last odometer/engine hours value that the device 

reported, and the date that it was reported. 

Below that, under “Last Calibration,” you’ll see the values for the last time the asset’s odometer or 

engine hours were calibrated. If they never were, you will see the accumulated odometer/engine hours 

received from the GPS. 

 

➌ Enter your new odometer/engine hours value in the “New odometer/engine 

hours reading” field and select “Save.” 

 

 

 

Once complete, your device will now record odometer or engine hours using that as the starting 

value. All recorded mileage or engine hours will be added on top of your value. 

 

 

 

 

         

 

The View dropdown menu is used to view and manage: 

 

1. Scheduled and Daily Actions that have been set up 

2. Action Progress 

3. Route Line Preference 

4. Show Radius Boundaries (set up under “Actions”) 

5. Show Geofences (set up under “Actions”) 

TIP: To change your units of measurement (ex. Km to Miles), select your username in the top right 
of AirIQ Fleet, then “Options” and select your choice from the window. 

 Using the View menu 



 

10 
 

 

               

Quick Access Guide 

 

You can add maintenance schedules and service records to your assets, depending on your 

company profile and your user access rights. 

 

 On AirIQ Fleet, select “Modules,” then “Maintenance.” 

 The Maintenance Module is located under the Modules drop down menu on the AirIQ Fleet 

toolbar, as indicated in the image below: 

 

 

Upon selection of “Maintenance,” you’ll see a screen with all of your company’s assets, each with 

“Schedules” and “Service” buttons respectively: 

 

 

 

 

 

 

 

 

 

You can use the “Filter Assets” and “Filter Fleets” fields above the table to search for an asset or fleet 

you’re looking for. 

 

 Adding Maintenance Schedules 
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 Select the respective                   button for the asset you wish to modify. 

 You will then see the following screen, showing any scheduled maintenance you already have, 
or in this case, nothing, as we have not added any schedules yet. You will also see the last reported 
engine hours and odometer.  

 

 

 

 

 

➌ Select “+ New Schedule” in the top right corner. 

 You will then see the following screen: 
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➍ Enter a Schedule Name and fill in the details for whichever type of 

schedule you need. Example below. 

 For example, if your schedule is odometer based, enter only the “Odometer Schedule” fields. 

 

EXAMPLE: The values for “Odometer Schedule” shown in the image above will produce the following 

results for an oil change schedule: 

1. The service interval is 5,000, so we will anticipate changing oil every 5,000 kms. 

2. The next service interval is 10,000, so we will be changing oil at 10,000 kms. 

3. The reminder is set to 1,000, so once we reach 9,000 kms, we will receive a notification 

advising us that our scheduled deadline for our oil change is coming up. 

 

➎ Once completed, select “Save.” 

This will add a new maintenance schedule to your asset, which you will now see by following step 2. 

 

 

 On AirIQ Fleet, select “Modules,” then “Maintenance.” 

 The Maintenance Module is located under the Modules drop down menu on the AirIQ Fleet 

toolbar, as indicated in the image below: 

 

 

 

 

 

 

 

 Adding Maintenance Service Records 
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Upon selection of “Maintenance,” you’ll see a screen with all of your company’s assets, each with 

“Schedules” and “Service” buttons respectively: 

 

 

 

 

 

 

 

 

 

You can use the “Filter Assets” and “Filter Fleets” fields above the table to search for an asset or fleet 

you’re looking for if you have many. 

 

 Select the respective                  button for the asset you wish to modify. 

 You will then see the following screen, showing any service you have already recorded, or in 
this case, nothing, as we have not added any yet. You will also see the last reported engine hours and 
odometer. 

 

 

➌ Select “+ New Service Record” in the top right corner and fill in the service 

details as prompted. 

  (screenshot below) 

 

 

 



 

14 
 

 

               

Quick Access Guide 

 

- 

➎ If you want to keep the service record open for completion later, select 

“Save.” Otherwise, to close the service record now, select “Close this 

service record after it has been saved,” then select Save. 

This will add a new service record to your asset, which you will now see by following step 2. 

 

➏ To close an open service record, open the service record by clicking       .      

 The following screen will show up, showing the details of the service record you are closing 

along with its maintenance schedules if there are any: 
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➐ Select           . 

Note: If you have maintenance schedules attached to this service record and you want them to 

update automatically, check the “Update Schedule” box before closing the service record. 

Otherwise, you will need to manually update the maintenance schedule. You will also not receive 

maintenance reminder notifications by email. 

 

 

 

 On AirIQ Fleet, select “Reports” and the reports dropdown will show: 

  

 Hovering over the title of a report will give you a brief description 
 highlighting the use of the report. 

 The amount or selection of reports you see is dependent on your 
 account settings and available access. 

 

 For this example, we will select the “History Replay” report.  

 

 

 Set your report criteria (assets, start/end dates, fleet(s), etc). Once 
complete, select “View Report.”  

 

 

 

 

 Accessing reports 
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Some reports have a “Report Format” field (shown above as “Standard”). Setting this to “Enhanced” 

and again selecting “View Report” will give you more detailed address information, additional asset 

information such as make, model, voltage, ignition and more. 

 

As long as there are results that meet your criteria as defined above, you will now see the report. The 

report can be exported to CSV, PDF, MHTML Excel and Word formats for external use, using the button 

highlighted below: 

 

  

 

 On AirIQ Fleet, select “Setup,” then “Geofences.”  

 The Geofence editor will open up in a new tab. 

 

 

 Adding geofences 
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 In the search box in the top left, enter an address or place of interest. 

  

 

Your entered location will then be displayed on the map. 

 

➌ To create your geofence, select one of the icons at the top of the map, as 

highlighted below: 

 
- 

  Draw a circular geofence (click and drag). 

 Draw a custom shaped geofence (click each corner of a shape). 

 Draw a square shaped geofence (click and drag). 

 

 

➍ Once you have drawn your geofence, you will get a pop up to enter your 

geofence details. Give your new geofence a name and confirm the address 

details: 

  (screenshot below) 
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➎ Once completed, select “Save.” 

 

➏ To edit, delete, or set notifications for a geofence, right click in the 

geofence. 

You will see a small box pop up with your geofence details, along with the following buttons: 
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 On AirIQ Fleet, select “Setup,” then “Notifications.”  

 For location of setup menu, see step 1 under “Adding geofences.”  

 

The Notification Setup page will appear, with all of your existing notification triggers, addresses and 

delivery windows. If you have none, this page will be blank.  

 

Note: You need to have users in your address book to utilize notifications. The address book is 

located just below the Notification Triggers box shown above. 

 

 Add subscriber(s) to the address book to receive alerts.  

 In the Address Book, select                   and fill in the required information in the popup: 

 

 

 

 

 

 

 

 

 

 Setting up e-mail and text notifications 
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➌ Select the trigger type that you require from the top right-hand side of the 

Notification Triggers box (shown above). 

 For this example, we will use                       . 

 

➍ Give your trigger a name, description (optional), and the events that alerts 

will trigger on. 

 

For example, a “Reckless driving”               

alert might use the following                                

alerts to trigger on: 

 

 

 

To set up a text notification (via SMS), get your carrier’s e-mail to SMS address format and add 

your phone number, then put the full address in the email field as shown above. 

 

The most common Email to SMS address formats are below: 

Carrier Email to SMS address format Example 

AT&T [ # ]@txt.att.net 9058316555@txt.att.net 

Rogers [ # ]@pcs.rogers.com 9058316555@pcs.rogers.com 

TELUS [ # ]@msg.telus.com 9058316555@msg.telus.com 

T-Mobile [ # ]@tmomail.net 9058316555@tmomail.net 

Verizon [ # ]@vtext.com 9058316555@vtext.com 

 

Putting 9058316555@txt.att.net in the Email field in the address book would send an alert upon the 

trigger to (905) 831-6555 as long as they are an AT&T customer. 

If you do not receive SMS alerts, confirm you have formatted the email correctly, and if so, contact your 

carrier. 

 

 

TIP: You can enable or disable a trigger at any time by ticking        Trigger Enabled   in the Alert 
Trigger Editor (under the description box). 

mailto:9058316555@txt.att.net
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 On AirIQ Fleet, select “Setup,” then “Users.” 

 For location of setup menu, see step 1 under “Adding geofences.” 

 

You will see all of the current users in your company (as shown below): 

 

 

 Select               in the top right corner of the “User Accounts” box. 

The User Email and Permissions box will appear with all of the available options (shown below): 

 

 

Enter the user’s email (which they will use to log in) and begin to set permissions for your user. You 

can select various general permissions under the “User Email and Permissions” box as shown above. 

 

 Setting up a new user 
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You can also choose the specific reports and actions your user(s) can access by scrolling down to the 

“Report Selection” and “Action Selection” boxes respectively: 

 

 

 

 

 

Upon completion of the form, select “Save” in the  top right corner (above the “User Email and 

Permissions” box). 

Note: The user whose email you enter in “Email” will receive an account activation email that will prompt 

them to set a password for access to AirIQ Fleet. 

 

 

 

 

 

TIP: You as an administrator do not have access to set or view user passwords. If a user has 
forgotten their password, they can select “Forgot your password?” on the login screen to reset it. 
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 On AirIQ Fleet, select your email in the top right and select “Options.” 

 The box shown below will pop up. This is where you can set all of your preferences when you 

use AirIQ Fleet. 

 Units of Measurement 

Your preferred units of measurement when working with an asset. This is also 

reflected in reports. 

 Map Defaults 

You can choose to show all of your assets when you log in to AirIQ Fleet by 

default. You can also choose to show the asset icons (ex. pickup truck icon if 

your asset is set as a pickup truck). 

Route lines can also be shown and are shown straight by default. This draws a 

line between points your asset has travelled to so you can visualize it easier. 

Stick to road allows these lines to lock on to roads, to create a more accurate 

visual. This feature is in preview mode so there may be inconsistencies. 

 Grid Settings 

You can choose the position that the data grid is shown, for example at the 

bottom of the screen or on the left/right side of the screen. 

If you expand the Grid Columns shown dropdown, you can also choose which 

columns you see on the grid (some of which are disabled by default, like fuel 

level and % fuel level). 

 Other 

You can choose your time zone which will be reflected in AirIQ Fleet and 

reports. You can also set an auto-refresh interval, where AirIQ Fleet will auto 

refresh every amount of time you set in this field to give you an up-to-date view 

on all of your assets. 

 

 

 

 

 

 Setting user options 
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Help Menu 

This guide is embedded in the Help menu (top right of AirIQ Fleet, beside your username/email), 

along with API documentation that is useful for developers. 

 

Change your password 

Select your username/email in the top right of AirIQ Fleet and select “Change Password.” You will 

receive an email with instructions on changing your password. 

There is certain criteria required when creating a password. Your password must have: 

- A minimum of 8 characters 

- At least one lower case letter 

- At least one upper case letter 

- At least one number 

- At least one character that is not a letter or a number. (ex: !, $, #, %) 

 

Logging off 

Select your username/email in the top right of AirIQ Fleet and select “Log off.” 

 

  

 Quick tips 


